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Introducción

Actualmente la informática forma parte de cualquier empresa, tanto de las grandes, medianas así como también de las pequeñas empresas. Por esa razón es seguro que las compañías requerirán tarde o temprano de los servicios de un equipo de analistas y programadores que ofrezcan las mejores soluciones para el éxito y buen desempeño de las un negocio.

No son las empresas las que tienen que acoplarse a los conocimientos de un analista o programador, sino por el contrario, el equipo de analistas y programadores tiene que conocer las mejores opciones en cuanto a software y hardware para ofrecer soluciones eficientes y eficaces a las empresas. Eficientes en cuanto ahorren tiempo, dinero y trabajo. Eficaces en el sentido de que las aplicaciones hagan lo que se desea lograr de acuerdo a lo planeado o requerido.

Por esta razón en este documento se hablará de PowerBuilder y de Toad, que son dos herramientas poderosas a disposición de las empresas, ya que permiten crear aplicaciones potentes y que gestionen y administren grandes bases de datos.

Otro de los aspectos importantes de las aplicaciones en estudio  es que son orientadas a internet, que es algo fundamental en la actualidad dados los beneficios que tiene ofrecer información, servicios o productos desde la red mundial conocida por todos como el internet.

Es muy claro que para el ambiente empresarial, una aplicación sin una base de datos no está completa, pues el objetivo de cualquier compañía es tener su información accesible para cuando se requiera, lo cual no es posible hacer sin una base de datos. En el caso de PowerBuilder y Toad, ambos ofrecen soluciones para manejar y gestionar bases de datos de gran tamaño, y se orientan a la web, siendo soluciones interesantes para las empresas, razón por la cual se estudiarán en esta investigación.

Objetivo

· Conocer de manera general en qué consisten los programas PowerBuilder y Toad, sus usos, requerimientos, compatibilidad, costos de licencia, ventajas, desventajas y las soluciones que son capaces de ofrecer a las empresas.
Justificación

Debido a que los analistas y programadores deben ofrecer soluciones a las empresas, se hace necesario y es fundamental que lo ingenieros o el personal del departamento informático de cualquier empresa conozca una amplia gama de lenguajes de programación, gestores de bases de datos y aplicaciones que permitan solucionar los problemas específicos de las empresas en el área de informática. Por esa razón, estudiar PowerBuilder y Toad es importante ya que son dos programas poderosos y con gran potencia para administrar bases de datos en una empresa, orientando los sistemas al internet si se desea. Se pueden crear aplicaciones robustas, seguras y escalables con estos programas, siendo herramientas de gran utilidad y dignas de estudio para los estudiantes de computación.

PowerBuilder

PowerBuilder es un lenguaje de programación de cuarta generación que ofrece las herramientas necesarias para la creación rápida de aplicaciones con capacidades de trabajo con bases de datos. Este programa fue creado por Powersoft y posteriormente comprado por Sybase (compañía de informática localizada en California, Estados Unidos), que es la empresa que actualmente desarrollo y da el soporte a Powerbuilder. La última versión de este programa hasta agosto de 2008 es la 11.2.
Con esta herramienta de desarrollo empresarial se pueden construir muchos tipos de aplicaciones cliente/servidor así como también aplicaciones para internet. PowerBuilder permite crear interfaces de usuarios con menús, ventanas y controles de ventanas, permitiendo al usuario interactuar directamente con la aplicación. Igualmente se puede trabajar con funciones, eventos, reglas de validación y muchas otras herramientas que usualmente se tienen en los lenguajes de programación de cuarta generación, incluyendo la orientación a objetos y todas las ventajas que este modelo de programación conlleva.

Otro aspecto relevante de PowerBuilder es el enfoque que tiene hacia las bases de datos, de manera que se pueden crear aplicaciones que no solamente hagan cálculos o procedimientos específicos, sino que también guarden resultados para poderlos manipular y volver a mostrar en el futuro.
Este programa es utilizado especialmente para aplicaciones de negocios. Hay también versiones de PowerBuilder que pueden ser usadas para construir aplicaciones que corran en dispositivos móviles tales como teléfonos o PDAs. PowerBuilder es usado comúnmente por compañías del sector financiero en los Estados Unidos, Canadá y el Reino Unido. También es usado por muchas agencias de gobierno. Hay miles de organizaciones alrededor del mundo que se siguen usando este programa. Es usado por grandes empresas, y tiene integración con aplicaciones web, lo cual lo hace mantenerse a la vanguardia, pues últimamente las tendencias van encaminadas al desarrollo web.

Desventajas de PowerBuilder

Entre las limitantes que se mencionan es que por ejemplo para desarrollar una solución que incluya código externo C++, podría no solamente requerirse un competente desarrollador de C++, sino también un experto en PowerBuilder que guíe el desarrollo. Esta es una de las limitantes que se pueden mencionar. Otra desventaja es que no hay una versión que se pueda instalar directamente en sistemas operativos UNIX/Linux ni en Mac OS.
Algo que podría también considerarse como desventaja es que PowerBuilder es un programa comercial y que los costos para adquirirlo son relativamente altos, a diferencia de otros programas más económicos e incluso algunos que son de uso libre como Linux o MySQL.

Ventajas de PowerBuilder

Son muchísimas las ventajas que se pueden mencionar de este programa. Para mencionar algunas, se puede hablar de la integración de este programa con otras aplicaciones. Esto es importante porque no es un programa aislado y cerrado sino que abierto en el sentido de la integración con otros lenguajes y plataformas de desarrollo Otra ventaja es que se pueden crear muchísimos tipos de aplicaciones en PowerBuilder, ya que responde a eventos, permite la programación orientada a objetos, es capaz de manipular y administrar bases de datos, etc. También permite a los desarrolladores crear código y aplicaciones reutilizables y utilizando módulos que faciliten darle mantenimiento a los programas y reutilizar partes de código en nuevos proyectos o programas que se deseen crear. Para ilustrar gráficamente la integración de PowerBuilder como una ventaja competitiva, se muestra la siguiente imagen:
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Es muy importante notar cómo PowerBuilder puede interactuar con otros lenguajes de programación y también con bases de datos originalmente creadas en gestores como Microsoft SQL Server, Microsoft Access, MySQL, ORACLE y con el propio lenguaje de consulta estructurado SQL.
Otra de las ventajas es el soporte que vende Sybase para este programa, pues aunque se paga un precio económico pero se obtiene a cambio un producto garantizado y comprobado en cuanto a su efectividad, ya que tiene muchos usuarios.

Requerimientos del sistema para utilizar PowerBuilder
PowerBuilder 11.2 es compatible con las siguientes plataformas y configuraciones de sistemas operativos:

· Microsoft Windows XP con Service Pack 2

· Microsoft Windows XP Tablet PC Edition con Service Pack 2

· Microsoft Windows Server 2003 con Service Pack 1

· Microsoft Windows Vista Business Edition

Los requerimientos del sistema para instalar PowerBuilder Enterprise 11.0 se muestran en la siguiente tabla:

	Herramienta
	Computadora
	Memoria mínima
	Espacio en disco duro
	Sistema operativo

	PowerBuilder
	Procesador clase Pentium III 600 MHz
	128 MB
	442 MB para todos los componentes
	Windows XP Professional con SP 2, Windows XP Tablet PC Edition con SP 2, o Windows Server 2003 con SP 1

	InfoMaker
	400 MHz o superior compatible con Pentium
	64 MB
	197 MB para todos los componentes*
	Windows XP Professional con SP 2, Windows XP Tablet PC Edition con SP 2, o Windows Server 2003 con SP 1

	SQL Anywhere
	400 MHz o superior compatible con Pentium
	48 MB adicionales a la memoria requerida por el sistema operativo
	242 MB para todos los componentes
	Windows 2000, Windows XP, Windows XP Tablet PC Edition, o Windows Server 2003


* Se requiere menos espacio en disco si PowerBuilder está instalado en la misma computadora.
Licencia de uso de PowerBuilder
Existen dos tipos de licencia que se pueden tener al comprar PowerBuilder: 

· Licencia local para un solo equipo 

· Licencia para servidor, de modo que el programa pueda ser usado por varias computadoras administradas por un servidor
Diferencias fundamentales entre las ediciones de PowerBuilder

La siguiente tabla en idioma inglés identifica las características sobresalientes en las ediciones Enterprise, Professional, y Desktop de PowerBuilder 10:
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Costo de licencias de PowerBuilder en El Salvador
El contacto de Sybase en El Salvador y la empresa a través de la cual se pueden adquirir las licencias y el soporte para PowerBuilder se llama Business Solutions, ubicada en la siguiente dirección y con el teléfono de contacto mostrado a continuación:

Blvd. Presidente 
Edif. Centro Profesional Presidente, 
Piso 2, Ofic. 24 
San Salvador 
SLV 

Teléfono: (503)2243 9700
Los precios de PowerBuilder en El Salvador hasta agosto de 2008 se listan a continuación:

	Programa y versión
	Precio

	PowerBuilder Desktop 11.1 para Windows x86
	$295.00

	PowerBuilder Professional 11.1 para Windows x86
	$1,295.00

	PowerBuilder Enterprise 11.1 para Windows x86
	$2,995.00

	PowerBuilder Application Server Plug-in Enterprise Edition 1.0 para Windows x86
	$495.00/CPU


A continuación se muestran los precios de soporte para PowerBuilder, que deben añadirse al precio de la licencia correspondiente de la tabla anterior, y así obtener el total a pagar, que es el precio del programa más el precio del soporte:

	Programa y versión
	Tipo de soporte
	Precio

	PowerBuilder Desktop 11.1 para Windows x86
	Standard
	$133.00

	
	Developer
	$8,000.00

	
	Enterprise Developer
	$35,000.00

	
	Incident Plan
	$2,200.00

	
	Incident Single Case
	$250.00

	
	No Support
	$0.00

	PowerBuilder Professional 11.1 para Windows x86
	Standard
	$583.00

	
	Developer
	$8,000.00

	
	Enterprise Developer
	$35,000.00

	
	Incident Plan
	$2,200.00

	
	Incident Single Case
	$250.00

	
	No Support
	$0.00

	PowerBuilder Enterprise 11.1 para Windows x86
	Standard
	$1,348.00

	
	Developer
	$8,000.00

	
	Enterprise Developer
	$35,000.00

	
	Incident Plan
	$2,200.00

	
	Incident Single Case
	$250.00

	
	No Support
	$0.00

	PowerBuilder Application Server Plug-in Enterprise Edition 1.0 para Windows x86
	Standard
	$223.00

	
	Developer
	$8,000.00

	
	Enterprise Developer
	$35,000.00

	
	Incident Plan
	$2,200.00

	
	Incident Single Case
	$250.00

	
	No Support
	$0.00


NOTA IMPORTANTE: los precios de los cuadros anteriores han sido tomados del sitio web oficial de Sybase. Pero es necesario tener en cuenta que Business Solutions, contacto de Sybase en El Salvador, informa que Sybase no vende productos sin mantenimiento. Por lo tanto, para el caso de realizar la compra en El Salvador, a los precios mostrados en las dos tablas anteriores, se les deben agregar costos de impuestos de esta manera: 27% más a los precios de los programas y 22% más a los precios de soporte o mantenimiento.
Instalación de PowerBuilder
La instalación de este programa se hace mediante un amigable asistente, tal como se muestra en las siguientes imágenes:
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Compatibilidad de PowerBuilder

Una de las importantes y destacables características de PowerBuilder es su compatibilidad con Microsoft .NET Framework 2.0 y 3.0, lo cual es definitivamente una excelente mejora que incorporan las últimas versiones de esta excelente herramienta de desarrollo.
Como se puede apreciar, PowerBuilder es un lenguaje con un entorno gráficamente amigable y con todas las riquezas de los lenguajes de programación de cuarta generación, que incluyen la orientación a objetos y gran potencia para el trabajo con bases de datos.

Ejemplo de una aplicación inicial creada paso a paso en PowerBuilder

PowerBuilder es un lenguaje con un entorno gráficamente amigable y con todas las riquezas de los lenguajes de programación de cuarta generación, que incluyen la orientación a objetos y gran potencia para el trabajo con bases de datos. Ahora se muestra ahora un ejemplo de cómo crear una aplicación desde cero en PowerBuilder:

Primeramente se debe crear un espacio de trabajo, que es el lugar donde se construye, edita, prueba y corre un programa a la hora de estarlo desarrollando. Se puede crear más de un programa en un solo espacio de trabajo. Para ello, iniciar el programa y aparecerá esta ventana:
[image: image14.png]Welcome to PowerBuilder |

PowerBulder can be used to creats Windows client applications,
server components, .NET Web and Windows Forms, .NET Web
services and assebies, and much more.

Each component or component collction s stored as a target.
Mulile targets are grouped together as a workspace.

Would you ke to;

reste a new workspace and 3 new target
reste a new workspace and add an existing target
Greste st a new workepsce

pen an existing workepace

Close this dislog box.

[ show this dielog box at startup with no workspace.

eload last workspace at startup





La ventana de diálogo anterior da la opción para crear un nuevo espacio de trabajo y añadir un nuevo programa o un programa ya existente a dicho espacio de trabajo. Al elegir la primera opción de la imagen anterior, aparecerá la siguiente ventana:
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Seleccionar New del menú File y aparecerá la siguiente ventana, donde se debe hacer clic en OK:
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Aparecerá el cuadro de diálogo para guardar el espacio de trabajo. Asignarle el nombre MyWorkspace y guardarlo en la carpeta Tutorial. Hacer clic en Save luego de haber elegido la ubicación deseada. Se debe notar que la extensión con que se guardan los espacios de trabajo es .pbw.
Ahora que ya se tiene el espacio de trabajo creado, seleccionar New del menú File y hacer clic en la pestaña Target. Luego elegir el ícono de Template Application y presionar OK. Luego seguir los pasos descritos en el asistente que va a aparecer, haciendo clic en Next hasta que aparezca la página Specify New Application and Library. Ponerle por nombre pbtutor a la aplicación y hacer clic en Next. Va a aparecer la página Specify Template Type. Dejar seleccionado el botón de radio en MDI Application with Microhelp. MDI significa Multiple Document Interface. Luego hacer clic en Next cuatro veces hasta que aparezca la página Name Individual Sheets. En la página Name Individual Sheets, escribir w_customers para Sheet1 1, w_products para Sheet 2 y dejar en blanco el cuadro de texto para Sheet 3.
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Hacer clic en Next y escribir Maintain Customers cuando aparezca el nombre para Sheet 1 y escribir Maintain Products cuando aparezca el nombre para Sheet 2. Esos nombres escritos se mostrarán en la barra de título de estas ventanas.
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Hacer clic en Next dos veces, pues no se necesitan cambiar los nombres de las ventanas About y Toolbar.

En la página Specify Connectivity, seleccionar None. Hacer clic en Next dos veces para que aparezca la página Ready To Create Application. Esta es la última página del asistente. Ahí se listan las selecciones actuales que se tienen para que se puedan revisar y usar el botón Back y cambiarlas si fuera necesario:
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Asegurarse de que el cheque esté puesto en Generate To-Do List. Hacer clic en Finish.
El asistente para la creación de la aplicación crea tanto el archivo pbtutor.pbt como también la librería pbtutor.pbl, al tiempo que fija por defecto la aplicación pbtutor.
Se tendrá lo siguiente:
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Ahora se tiene que especificar un ícono para la aplicación. Este ícono aparece en el espacio de trabajo cuando se minimiza la aplicación durante la ejecución. PowerBuilder incluye el ícono automáticamente cuando se crea un archivo ejecutable. 

Hacer doble clic en el objeto pbtutor Application en el Árbol del Sistema y seleccionar Edit de la ventana emergente. Aparece la vista Properties, que también se puede abrir con clic en el menú View y finalmente clic en Properties.
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Hacer clic en el botón Additional Properties, seleccionar la pestaña Icon y hacer clic en Browse. Navegar hasta el directorio Tutorial. Seleccionar el archivo tutorial.ico y hacer clic en Open. Aparecerá lo siguiente:
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Hacer clic en el botón OK. Hacer clic en el menú File y luego Save. Finalmente hacer clic en el menú File y después Close. 
Se puede cambiar el tamaño de la ventana principal de la aplicación. Cuando se corra la aplicación, la ventana principal se mostrará en la ubicación y tamaño especificados. Para esto hacer doble clic en w_pbtutor_frame en el Árbol del Sistema. Verificar que aparezca el cheque en Center, en la pestaña General de la vista de Properties. Ahora cuando se corra la aplicación, la ventana aparecerá centrada. Luego bajar con el scroll del mouse y seleccionar normal!  En la lista de selección múltiple de la sección WindowState.
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Hacer clic en la pestaña Other en la vista Properties. Escribir 3000 en el cuadro de texto Width y 2400 en el cuadro de texto Heigh. Con esto se obtendrá una ventana rectangular. Los valores están en PowerBuilder Units (PBUs). Presionar la tecla Tab.
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Seleccionar File y luego Close en el menú principal del programa. Hacer clic en Yes cuando aparezca la pregunta sobre si se desean guardar los cambios. Cuando se corra la aplicación, la ventana aparecerá centrada y con el tamaño especificado.

Se tiene que ejecutar la aplicación para ver cómo funciona hasta este momento. Hasta este punto la aplicación no hace casi nada, pero ya se podrá ver algo por lo menos. Hacer clic en el botón Run:
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Seleccionar el menú File, luego New y finalmente Maintain Customers. Aparecerá la siguiente ventana:
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Se puede observar que la barra de título contiene el nombre que se puso anteriormente en el asistente, cuando se escribió Maintain Customers para Sheet 1.

Seleccionar File>New>Maintain Products. Aparece una segunda ventana de la aplicación. Seleccionar Window >Title Horizontal. Las ventanas se ubican horizontalmente dentro del marco MDI, con la ventana activa hasta arriba. Ahora seleccionar File>Toolbars en la barra de menús. La aplicación muestra el cuadro de diálogo Toolbars. Seleccionar Floating en el cuadro de diálogo Toolbars. La barra de herramientas flota dentro del marco MDI. Podría ser necesario mover el cuadro de diálogo Toolbars para ver la barra de herramientas flotante. Ahora seleccionar Top. La barra de herramientas es reposicionada hasta arriba del marco. Hacer clic en Done para cerrar el cuadro de diálogo Toolbars. Seleccionar File>Exit. Con ello la aplicación se cierra y se retorna al entorno de desarrollo del PowerBuilder.

Es así como se ha mostrado paso a paso cómo crear una aplicación en PowerBuilder. Por supuesto que a los formularios se les deberán insertar objetos y luego a lo objetos código para que respondan a determinados eventos. Igualmente PowerBuilder ofrece alto rendimiento en el uso de bases de datos en las aplicaciones creadas. Todo esto se podrá ir haciendo poco a poco, conforme el programador se vaya familiarizando y aprendiendo más sobre este útil programa.
Toad
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Toad es un programa de desarrollo y administración de bases de datos que incrementa la productividad del usuario y la calidad del código de las aplicaciones, mientras provee ayudas interactivas para aprender a utilizar el programa, así como una comunidad de usuarios en la que se puede participar y colaborar o aprender de las experiencias y conocimientos de otros desarrolladores que hacen uso de Toad.
Toad fue originalmente diseñado por un desarrollador que utilizaba Oracle llamado Jim McDaniel, quien llamó al programa que había creado de esta manera: “Tool for Oracle Application Developers”. De ahí viene el nombre TOAD, que en español esto significa Herramienta para Desarrolladores de Aplicación Oracle. En 1998, Quest Software (empresa de informática localizada en California, Estados Unidos) adquirió el programa de Jim McDaniel y es esta compañía la que desarrolla, diseña y provee Toad en la actualidad.
Aunque inicialmente y como el acrónimo mismo lo sugiere, Toad estaba orientado únicamente a Oracle, actualmente se ha expandido y soporta o puede administrar y trabajar con las siguientes bases de datos:

· Oracle Database

· Microsoft SQL Server

· IBM DB2

· MySQL

Toad puede ser usado por medianas y grandes empresas especialmente. Es momento de hablar de las ventajas y desventajas de este popular programa.

Desventajas de Toad

Entre las desventajas podría mencionarse que tiene un costo de adquisición por ser un producto con fines de lucro. Existen otras soluciones como la utilización de otros gestores de bases de datos tales como PostgreSQL o MySQL, que son programas de uso libre y no se tiene que incurrir en gastos de licencia, sino que se pueden descargar directamente de internet.

Otra desventaja de Toad es que no es compatible con PostgreSQL, que aunque no tiene tantos usuarios como MySQL, pero no deja de ser una herramienta poderosa y utilizada por muchos desarrolladores para administrar bases de datos.

Otra desventaja es que no hay versiones de Toad para sistemas operativos UNIX/Linux ni para Mac OS. Toad funciona únicamente bajo un entorno operativo Windows.
Ventajas de Toad

Entre las ventajas de Toad se tienen la compatibilidad con cuatro de los más populares gestores de bases de datos que existen en la actualidad. Con Toad se pueden administrar estos cuatro poderosos gestores de bases de datos: Oracle Database, Microsoft SQL Server, IBM DB2 y MySQL.

Otra de las ventajas notables de Toad es la comunidad de usuarios que ofrecen, donde se pueden encontrar muchas ayudas para aprender a usar este programa y para encontrar soluciones a problemas particulares. Todo esto se encuentra accesible directamente desde http://www.toadworld.com/.
Requerimientos del sistema para utilizar Toad

Toad se ejecuta en todas las plataformas Windows de 32 bit, incluyendo Windows 95, 98, NT, 2000, XP y Vista. Los requerimientos de hardware son tales que si se puede utilizar normalmente el sistema operativo, seguramente Toad también funcionará en ese equipo.
Licencia de uso de Toad

Existen dos tipos de licencia que se pueden tener al comprar PowerBuilder: 

· Licencia local para un solo equipo 

· Licencia para servidor, de modo que el programa pueda ser usado por varias computadoras administradas por un servidor

La licencia para servidor se ejecuta en Apache Tomcat, que es automáticamente instalado con la licencia para servidor.

Costo de Licencias de Toad
Este programa puede ser comprado por internet, y estos son los precios para un solo equipo hasta agosto de 2008:

	Programa
	Precio

	Toad DBA Suite for Oracle
	$4,995.00

	Toad Data Modeler
	$479.00

	Toad Development Suite for IBM® DB2® for LUW
	$2,990.00

	Toad Development Suite for Oracle
	$2,990.00

	Toad for Data Analysis
	$499.00

	Toad for IBM® DB2® Standard Edition for LUW
	$870.00

	Toad for IBM® DB2® Standard Edition for z/OS
	$870.00

	Toad for IBM® DB2® Professional Edition for LUW
	$1,500.00

	Toad for IBM® DB2® Professional Edition for z/OS
	$1,500.00

	Toad for IBM® DB2® Xpert Edition for LUW
	$2,500.00

	Toad for IBM® DB2® Xpert Edition for z/OS
	$2,500.00

	Toad for Oracle Base Edition
	$870.00

	Toad for Oracle DB Admin Module
	$810.00

	Toad for Oracle Professional
	$1,465.00

	Toad for Oracle Xpert
	$2,275.00

	Toad for SQL Server Professional
	$595.00

	Toad for SQL Server Xpert
	$1,045.00

	Toad® Development Suite for SQL Server
	$1,295.00

	Toad for MySQL
	No encontrado


La compra de estos productos se puede realizar directamente desde la página de internet oficial de Quest Software, que es la empresa que fabrica, vende y da soporte al programa Toad.
Conclusión
Luego de haber estudiado de manera global los programas PowerBuilder y Toad, se puede concluir que ambos son herramientas de gran potencia y que es muy importante conocerlas para tener la preparación adecuada para determinar si vale la pena hacer una inversión o no en estos programas. En el campo laboral se dan casos específicos donde las empresas requieren soluciones a sus problemas, por lo cual es necesario tener una idea general pero a la vez clara de lo que son los programas y herramientas que existen en el mercado, sus ventajas y desventajas, precios, etc.
Esta investigación ha dado una idea general de lo que se puede hacer con PowerBuilder y con Toad, habiendo resultado provechosa para conocer la utilidad y los usos que se les puede dar a estos programas, para que cuando se den casos específicos de soluciones que se necesite ofrecer a las empresas, poder determinar si es ideal o no utilizar PowerBuilder y Toad, considerando todos los aspectos como precio, escalabilidad, soporte técnico de los proveedores de estos lenguajes, facilidad de aprendizaje, etc. Esto ayuda para tener un listado de posibles herramientas a utilizar, y seleccionar la que más conviene en todos los sentidos, pues como se dijo anteriormente, no es la empresa la que se tiene que acoplar a los conocimientos del analista o programador, sino que es el equipo de analistas y programadores el que tiene que ofrecer la solución más conveniente para dar solución a los problemas de las empresas.
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